
1.3

 
WATCHPAX 62  
USER’S GUIDE



DATATON WATCHPAX 62 – USER’S GUIDE	 TABLE OF CONTENTS

1. INTRODUCTION	 4
What’s WATCHOUT?	 4

System Overview	 5
WATCHPAX 62 In Your Rig	 5
Display Devices	 5
Start up Screen	 5

Accessories	 6
Supplied	 6
Available Separately	 6

Technical Data	 6
Power 	 6
SSD models A, B, C	 6
SSD model S	 6

Environmental	 7
Media Server Operating System	 7

2. INSTALLATION AND OPERATION	 8
Before Using Your WATCHPAX 62	 8
Safety First	 8

Ventilation/Airflow	 9
Installation	 9
Connect to Power	 9
Standalone Installation	 9
Installation in 19-inch Rack	 9
Operation	 9
First Power On	 9
Power On	 10
Power Off	 10
Reset WATCHPAX 62	 10
Reset and Keep User Data 	 10
Reset to Factory Settings 	 11
Reset Procedure 	 11
Delete Files	 13

Rebuild Show Cache	 13

3. QUICKSTART GUIDE	 14
The Basics	 14
Manage Network Settings	 14
Set Native Resolution	 15
Auto Start	 15

4. SYNCHRONIZATION	 16
External Timecode	 16

GPU Synchronization – Models B, C 	 17
Configure GPU Synchronization	 17
Interpret Status LEDs	 18
Connect GPU Synchronization	 19

SDI Synchronization – Model C Only	 19
Mode 1: Internal Sync	 19
Mode 2: SDI Sync Connector	 19
Mode 3: SDI Connector	 20

5. EDID MANAGEMENT	 21
EDID Management for Playout	 21
Access EDID Management Settings 	 21
Export EDID 	 22
Load EDID	 23
Unload EDID 	 24

EDID Management for HDMI Capture	 25
Access Capture Settings 	 25
Export EDID 	 27
Load EDID	 29
Unload EDID	 30

6. WATCHPAX 62 MODEL S	 31
WATCHOUT version 	 31
Dimensions	 31
Shipping Dimensions 	 31
Front View	 31
Connectors	 32

7. WATCHPAX 62 MODEL A	 33
WATCHOUT version 	 33
Dimensions	 33
Shipping Dimensions 	 33
Front View	 33
Connectors	 34

8. WATCHPAX 62 MODEL B	 35
WATCHOUT version 	 35
Dimensions	 35
Shipping Dimensions 	 35
Front View	 35
Connectors	 36

DATATON WATCHPAX 62 – USER’S GUIDE



DATATON WATCHPAX 62 – USER’S GUIDE	 TABLE OF CONTENTS

9. WATCHPAX 62 MODEL C	 37
WATCHOUT version 	 37
Dimensions	 37
Shipping dimensions 	 37
Front View	 37
Connectors	 38

10. WARRANTY, CONFORMITY AND 
DISPOSAL	 39
Limited Warranty	 39
FCC Notice	 40
Declaration Of Conformity	 41
Disposal	 42

11. SUPPORTED FORMATS	 43
Video Capture Formats	 43
HDMI Input (Models A, B, C)	 43
SDI Input Capture Formats (Model C)	 43
SDI Output Formats (Model C)	 44

Timecode Input Formats	 45
Analog Audio Output Formats (A, B, C)	 45
Digital Audio Output Formats	 45
DisplayPort Output Formats	 46
Adapters 	 46
HDCP 	 46

Playback Formats 
Hardware Accelerated Video Formats	 46

This manual is © Copyright 2023 DATATON AB 
(“Dataton”). All rights reserved. 

Dataton, the Dataton logo, WATCHPAX, 
WATCHOUT are registered trademarks/trade-
marks of DATATON AB. All other company and 
product names are trademarks or registered 
trademarks of their respective owners. Use of a 
term in this publication should not be regarded 
as affecting the validity of any trademark.

The information in this manual has been checked 
and is believed to be accurate. However, Dataton 
assumes no responsibility for any inaccuracies 
or errors in this manual or the products described. 
In no event will Dataton be liable for direct, 
indirect, special, incidental, or consequential 
damages resulting from any defect or omission 
in this manual, even if advised of the possibility 
of such damages. The technical information 
contained herein regarding features and 
specifications is subject to change without notice. 
Products and manufacturers mentioned do not 
constitute a recommendation or endorsement by 
Dataton.

Document number: 3790/rev 3.6 
Dataton AB, Teknikringen 22, 583 30 Linköping, Sweden

This manual refers to the "WATCHOUT USER'S 
GUIDE." Get the latest version here: 

https://www.dataton.com/support/user-guides

https://www.dataton.com/support/user-guides


Introduction	 4

1. INTRODUCTION

WATCHPAX 62 is a series of dedicated media servers available in four models (S, A, B, C). The server 
offers four video outputs, dual HDMI inputs (models A, B, C) and a high-performance specification 
designed solely with WATCHOUT shows  in mind. The four DisplayPort outputs support 4K (UHD) 
playback, making it a powerful and portable alternative in a multi-display setup. 

WATCHPAX 62 is a locked-down unit, preconfigured for playback of WATCHOUT shows. Multiple 
units can be installed together in a rig or with Dataton’s other WATCHPAX media servers.

WATCHPAX 62 has a compact, portable 2U form factor designed for tabletop or rack use (rack rails 
and ears supplied separatly). 

Each unit weighs approximately 10 kg and has rugged, aluminium housing with superior finish.

WHAT’S WATCHOUT?
Dataton WATCHOUT is the leading multi-display production and playback software. Use 
WATCHOUT to orchestrate images, video, lighting, 3D and interactivity into a single impressive show. 
The essential components of a WATCHOUT show are the software, media servers (such as 
WATCHPAX 62) and display devices (projectors, LED displays, etc), running on a standard network. 

In an operational setup, a WATCHOUT license key is required for the production computer running 
the show and each media server. All Dataton-branded media servers, including the WATCHPAX 62, 
have the license key built in. 

WATCHOUT shows can be presented with multiple projectors for large, seamless images or used with 
monitors, LED walls or other creative screen arrangements. WATCHOUT also has a strong set of pro-
jection and pixel-mapping features for applying content to complex three-dimensional objects.

Download WATCHOUT for free from the Dataton website: www.dataton.com

 

http://www.dataton.com
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SYSTEM OVERVIEW
WATCHPAX 62 is used as part of a WATCHOUT multi-display system.

Production 
computer

Network switch

WATCHPAX 62
media server

 A small WATCHOUT system with WATCHPAX 62

In the schematic above, there is a laptop (production computer) running WATCHOUT software and 
equipped with a WATCHOUT license key. This connects to a network switch which, in turn, connects 
to a Dataton WATCHPAX 62 media server. The WATCHPAX unit connects and manages the display 
devices. In the example, these consist of four LED screens. 

WATCHPAX 62 IN YOUR RIG
The WATCHPAX has four DisplayPort outputs. Used as is, it will manage four display devices in your 
presentation. Splitters may also be used to increase the number of display devices managed. The 
system is scalable; as the number of display devices increases, add more media servers to your rig. 

To implement the bi-directional SDI in WATCHPAX 62 C model, please read “9. WATCHPAX 62 
MODEL C” and “4. SYNCHRONIZATION”. 

As all Dataton-branded media servers have a built-in WATCHOUT license, the only additional license 
key required is for your production computer. If you are not using a Dataton media server you will 
need a WATCHOUT license key for each media server/display computer. 

DISPLAY DEVICES
The schematic shows four LED screens used as the display devices. WATCHOUT can be used with virtu-
ally any display device that can be connected to a computer (projectors, LCD panels, LED walls etc). 

START UP SCREEN
This is shown on all display devices connected to the WATCHPAX 62 at start-up, or if WATCHOUT has 
been re-launched. There are three lines of information:  

First line: Computer and cluster name (if this has been set in the WATCHOUT Production software 
Network window – please see the “Network Window” section in Chapter 3: Windows, “Dataton 
WATCHOUT User’s Guide” for more information), IP address for the media server.

Second line: Version number of the WATCHOUT display software currently installed on the media server. 

Third line: Media server model type, serial number, firmware version
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ACCESSORIES

SUPPLIED
	 1 x power cord with IEC 60320 C13 connector

	 4 x Accell DisplayPort 1.4  to HDMI 2.0 adapters (models A, B, C only)

	 1 x audio XLR breakout cable (models A, B, C only)

	 9 x micro BNC to BNC adapters (model C only)

	R ubber feet (for tabletop/standalone use)

AVAILABLE SEPARATELY
	R ack kit for mounting the unit to a 19” rack

	 Fan filter as a replaceable spare part

	 Micro BNC to BNC adapters (model C)

TECHNICAL DATA

POWER 
	 Input voltage: 100-240V 
	R ated frequency: 47 Hz ~ 63 Hz 
	 Power consumption 500W max

SSD MODELS A, B, C
	 Standard: 3.8 TB 
	O ptions: 7.6 TB, 15.3 TB (for additional options, please contact Dataton)  

SSD MODEL S
	 Standard: 1.9 TB

Unit with rails mounted for rack use 

WATCHOUT start-up screen
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ENVIRONMENTAL
Temperature range 
	O ptimal ambient temperature range for operation 21 °C to 23 °C	
	O perating 0 °C to +35 °C
	 Storage and transportation -20 °C  to +40 °C
Relative humidity 
	O ptimal 45% to 50%
	O perating 20% to 85 % (non-condensing)
	 Storage and transportation 10% to 90% (non-condensing)
Altitude 
	O perating, maximum 2000 meters above sea level

Noise 
	 Approximately 50 dBA during normal operation

Remember that noise levels are perceived differently by different people. Bear this in mind when 
choosing the installation site for your servers. 

MEDIA SERVER OPERATING SYSTEM
The operating system in WATCHPAX 62 has been optimized and licensed for this specific media 
server configuration. 

Do not install or attempt to install any software on the locked-down media server (such as drivers, 
software updates, security updates, virus protection, etc). Doing so will automatically void the unit’s 
warranty.

For security reasons, media servers should always be installed and operate on a separate network, 
without access to other networks. 
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2. INSTALLATION AND OPERATION

BEFORE USING YOUR WATCHPAX 62
Please read the manual thoroughly before operation. Always check that the unit has not been 
damaged in transit when you take delivery. 

IMPORTANT: The WATCHPAX 62 is a plug-and-play unit. Do not open, modify or repair the unit 
yourself. Opening, modifying (software or hardware) or repairing the unit yourself willl invalidate the 
warranty and presents a risk for the user. 

SAFETY FIRSTThis product must be grounded. Ensure you connect the power plug to a grounded power socket.

•	Insert the power plug all the way in, so it is not loose.

•	Do not place the power cord or product near heat sources.

•	Caution: shock hazard if handled carelessly or inaccurately.

•	Never install the product in a narrow space with bad ventilation. Do not block the ventilation in any 
way when operated. Always keep front and back of unit clear, minimum 200 mm.

•	Keep the plastic packaging bag for the product in a place that can not be reached by children.

•	Do not install the product in a place where it is exposed to dust, moisture, oil or smoke.

•	Take care not to drop the product when moving it.

•	When installing the product on a shelf, ensure the bottom edge of the product does not protrude to 
avoid tipping or other potential mishaps.

•	For pluggable equipment the socket outlet should be easily accessible.

•	Do not install the product on an unstable or vibrating surface.

•	Installing the product in an unusual place (a place where the product is exposed to a lot of dust, 
chemical substances, high temperatures, presence of moisture etc) may seriously affect its 
performance and lifetime. 

•	Install the product in a clean, dry area without excessive particles or dust, in the air (preferably in an 
air-conditioned server room). Do not install the product in a place where it is exposed to high 
temperature, chemicals, dust, moisture, oil or smoke.

•	High voltage runs through the product. Do not attempt to disassemble, repair, or modify the product on 
your own. To move the product, first disconnect all the cables from it.

•	If the product generates a burning smell, or smoke, remove the power cord immediately and contact 
Dataton.

•	If the product falls, or the exterior is damaged, power off the product, remove the power cords and 
contact Dataton.

•	If there is a risk of thunderstorm or lightning strike, turn off the power and disconnect all cables.

•	Ensure the front and back side are not blocked in any way. These are necessary for proper 
ventilation.

•	Do not insert a metallic object or inflammable object into any opening of the product.
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•	Unplug this product from the AC power supply before cleaning. Do not use liquid or aerosol 
cleaners on the product. Use a microfiber cloth for cleaning.

•	After storage in cold conditions, let the product adapt to normal temperature for two hours before 
powering on.

•	This equipment design typically applies to industrial equipment expected to be installed in locations 
where only adults are normally present. If installed by an ordinary person, the installation 
instructions must be made available for them.

VENTILATION/AIRFLOW
Airflow is critical for the correct operation of WATCHPAX 62 which means that the front and rear sides 
must not be blocked. The rear is where the connectors are located. 

Air flows from the front of the unit to the rear (where the connectors are located). Always keep both 
front and rear panels clear of obstruction at all times.

Do not install WATCHPAX 62 in a confined space. 

INSTALLATION

CONNECT TO POWER
•	This equipment is for professional use expected to be installed in locations where only adults are 

normally present. Check the “Safety First” list before use. 

•	The WATCHOUT 62 must be connected to a properly grounded wall socket (a socket-outlet with 
protective earth connection in the building). 

•	Disconnect all power sources before moving or doing any work on the product.

•	Caution: Shock hazard may occur if the product is handled carelessly or inaccurately

•	The serial number is located on the base of the unit.

STANDALONE INSTALLATION
Place the unit flat with the base down.

Mount the four self-adhesive rubber feet (supplied) at the points indicated on the base of the unit. 

INSTALLATION IN 19-INCH RACK
The WATCHPAX 62 unit may be mounted in a 19-inch rack by using the optional rack kit. Please refer 
to separate instructions for rack kit assembly.

OPERATION

IMPORTANT: Only use the power cable that is delivered with the WATCHPAX 62 unit. 

WATCHPAX 62 has a single IEC 60320 C14 power inlet.

FIRST POWER ON
The first time you power up a WATCHPAX 62 (after delivery or after a reset) the system will finalize 
installation and reboot several times. This procedure will typically take about 5 minutes to complete.  
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IMPORTANT: Do not interrupt this procedure. The first power-on updates firmware of critical 
components. Forcefully powering off the system during the configuration process might result in non-
working hardware components (i.e., capture devices will stop working).

POWER ON
The WATCHPAX 62 is turned on by inserting the DC power cord and then pressing the power button 
on the front of the unit for four seconds. Wake on LAN (WOL) may also be used. 

POWER OFF
Powering down should be initiated from within WATCHOUT production software. 

When the power-off sequence is complete, the fans will turn off, and the power cord may be removed. 

There are three ways to power off from WATCHOUT, as described in the “Manage Display 
Computer” section in Chapter 3: Windows, in the “Dataton WATCHOUT User’s Guide.” 

•	Use Manage Display Computer > Power Down found in the Stage main menu. 

•	Use the Manage Display Computer context menu when a display is selected on the Stage.

•	Use the Remote Access to initiate shutdown directly from the media server.

NOTE: If you are unable to shut down via the software, you can force shutdown with the power button 
as a last resort. Please be aware that this may cause data loss and system corruption. To force 
shutdown in this way, press and hold the power button (located on the front of the media server) for at 
least 5 seconds. The light will then turn off and the power is cut. 

IMPORTANT: Do not unplug the power cord during power-off as this may cause data loss and system 
corruption. 

RESET WATCHPAX 62
There are occasions when you may want to reset a WATCHPAX 62, for example, if the unit has been 
corrupted, or if it is a rental unit and user-specific info has to be removed between rentals. 

There are two levels of reset: 

•	 Reset and keep user data. This resets the operating system, display, GPU and capture settings but 
retains user data, such as shows and media. 

•	 Reset to factory settings. The takes the unit all the way back to the original factory settings‚ you lose 
all user data. 

IMPORTANT: A reset, regardless of level, is an advanced measure. Make sure you are fully aware of 
what data you lose when you reset!

RESET AND KEEP USER DATA 
This option resets the system partitions but keeps all user data such as: 

•	 Shows 

•	 Media 

•	 WATCHOUT settings 

•	 Startup script  
	 - Network settings  
	 - Timecode settings 
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Driver-related settings will be reset to default factory settings such as: 

•	 Display settings  
	 - Display mode  
	 - EDID caching 

•	 GPU settings  
	 - EDID emulation  
	 - Synchronization 

•	 Capture settings  
	 - Color domain, etc. 

IMPORTANT: EDID settings on the HDMI capture card are not deleted. This data is stored on the card 
itself and needs to be removed separately. 

RESET TO FACTORY SETTINGS 
This resets all partitions to factory settings and all user data will be lost. This level of reset is suitable 
when you want to remove all settings between projects. 

IMPORTANT: EDID settings on the HDMI capture card are not deleted. This data is stored on the card 
itself and needs to be removed separately. 

RESET PROCEDURE 
The reset menu is purposely hidden in order to avoid accidental resets or misuse. To reset your 
WATCHPAX 62 device, follow these 10 steps: 

1. Power off the WATCHPAX 62.

2. Disconnect all USB devices.

3. Insert a keyboard into one of the USB ports.

4. Connect at least one display device to a DisplayPort output. 

5. Power on the WATCHPAX 62.

6. During startup, you will see a five-second countdown in the top left corner of the display. Press Esc 
during this countdown. 

NOTE: If you don’t see a counter, it means the display devices are slow to lock to the output using 
DisplayPort. In this case, press “Esc” five seconds after the startup beep.  

5

5
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7. Select the desired reset option in the menu that appears, and press Enter.

8. IMPORTANT: There will be no confirmation: the reset process starts immediately, providing some 
visual feedback. 

9. The WATCHPAX 62 will restart several times in order to configure the operating system and 
hardware. 

IMPORTANT: Do not power off the device during the configuration process! 
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10. WATCHOUT will start when the process is complete. The system image version (r#) will be 
appended after the serial number.

DELETE FILES
To remove unused files from the WATCHPAX unit, open WATCHOUT on the production computer on 
the network. Go to the Stage menu, as below: 

Stage > Manage Display Computer > Delete Other Shows

This deletes files from online display computers for all shows, with the exception of  the current (open) 
show. 

REBUILD SHOW CACHE
WATCHOUT usually manages the cached data associated with the current (open) show automatically. 
This ensures that the files stored on your WATCHPAX 62 reflect the latest version of the show. 

If the files on the WATCHPAX 62 have been corrupted in some way, you may want to force the show 
cache to rebuild.

Open WATCHOUT on the production computer on the network. Go to the Stage menu, as below:

Stage > Manage Display Computer > Re-build Show Cache

This removes and rebuilds all cached data associated with the current show. 
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3. QUICKSTART GUIDE

THE BASICS
•	Connect displays to the WATCHPAX 62. 

•	 Connect the network to the WATCHPAX 62 using the Ethernet 1 port. The Ethernet 2 port is currently 
disabled and reserved for future use. 

•	 Power up the WATCHPAX 62 (see “Power On”).

•	 Start WATCHOUT software on the production computer which is on the same network.  
Important: Make sure you are using WATCHOUT version 6.7.2 or higher. Lower versions do not 
support WATCHPAX 62 usage.

•	 The WATCHPAX and any WATCHOUT display computers on the local network will be listed in 
Window > Network. Assign display and cluster names (if required) by double-clicking an item in the 
list, see screenshot. 

MANAGE NETWORK SETTINGS
WATCHPAX automatically retrieves an IP address via a DHCP server. If no DHCP server is available, 
the WATCHPAX will get a self-assigned IP address in the range 169.254.x.y

If you are using a control system, you may want to use a fixed IP address for WATCHPAX. Still in 
WATCHOUT, assign a fixed IP through the WATCHOUT protocol command “setIP” in the Startup Script 
as shown below:

authenticate 2 
setIP 192.168.0.32

Make sure you choose an IP address in the correct subnet range. To remove the fixed IP number, use 
the same command but with an empty string parameter, as below:

authenticate 2 
setIP 

WATCHPAX and display computers  
on the network
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The WATCHPAX 62 may also be addressed by name and/or cluster. Please see the “Network 
Window” section in Chapter 3: Windows, “WATCHOUT User’s Guide” for more information about 
this feature.

SET NATIVE RESOLUTION
Double-click the display in the Stage window and set the native resolution of your screen or projector, 
see screenshot.

AUTO START
A WATCHOUT production computer has to be connected when you compose or create your show. 
When you have composed your show, you can replace the production computer with an external 
control system, or auto-start the WATCHPAX by using the built-in Startup Script. 

NOTE: Use Edit Startup Script in WATCHOUT to define initial WATCHPAX settings. This lets you load 
shows and perform other WATCHOUT protocol commands. For more information, please see  the 
section on“Display Software,” Command Line Options, “WATCHOUT User’s Guide”.



SYNCHRONIZATION	 16

4. SYNCHRONIZATION

WATCHPAX 62 offers three kinds of synchronization: 

•	 Models  S, A, B, C: Standard, WATCHOUT network-based synchronization. This will keep all 
media servers in the WATCHOUT cluster synchronized. The sync signal comes from either the 
production computer or the WATCHPAX 62 acting as the cluster conductor. 

•	 Models S, A, B, C: External timecode. The WATCHOUT system can be slaved to an external linear 
timecode source (LTC). The LTC signal can be fed to the production computer or to the display 
cluster master, (see “External Timecode”).

•	 Models B, C: Hardware-locked synchronization between display clusters. This can be achieved in 
two ways: using the built-in synchronization card, (see “GPU Synchronization – Models B, C”), 
using an external sync connected to the sync input on the SDI card, (see “SDI Synchronization – 
Model C Only”).

To configure and setup synchronization, access each media server locally. Do this either by a Remote 
Access (from the WATCHOUT production computer) or connect a USB keyboard/mouse and screen to 
your WATCHPAX 62. 

Connecting by Remote Access will automatically bring up the WATCHOUT Display window 
(WATCHPOINT). If you are using a local keyboard/mouse and screen, enter Ctrl-W to bring up this 
window. You’ll find more on this in the “Dataton WATCHOUT User’s Guide” in the section on “Display 
Devices” (Chapter 2:  Installation) and “Remote Access” (Chapter 4: Commands).

EXTERNAL TIMECODE
For this to work, timecode must be enabled in the startup script. Read how to do this in the section on 
“List of Commands/timecodeMode” (Appendix C: Control Protocol) in the “Dataton WATCHOUT 
User’s Guide.” 

Open the WATCHOUT Display menu (WATCHPOINT, Ctrl-W) and select the interface you want to use 
under “Timecode”.

Models A, B, C: Connect the external timecode source to the audio input using the Left In 1 connector 
on the XLR break-out cable. See “Analog Audio Output Formats (A, B, C)”. 

Model S: As this has no audio input, an external USB device is needed to input the timecode signal.
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GPU SYNCHRONIZATION – MODELS B, C 
The WATCHPAX 62 is equipped with a synchronization card which makes it possible to achieve 
frame-lock, synchronization between GPUs and synchronization to an external timing source. 

CONFIGURE GPU SYNCHRONIZATION
Open the WATCHOUT Display File menu and click GPU settings. 

Navigate to Synchronize Displays and set the Timing Server to “On this system”. 

Enter the Server settings.

Set to “On this 
system”
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Here you can either choose the internal timing of this WATCHPAX 62 to be used across your system 
or, if an external sync generator is connected to your sync card, set it to “An external house sync 
signal”.

Make sure that synchronization is set up correctly by navigating to “View System Topology”.

INTERPRET STATUS LEDS
•	 Solid orange: Port is output but no signal is present. 

•	 Solid green: Port is input but no signal is present.

•	 Flashing orange: Port is output and transmitting. The flashing frequency indicates the refresh rate of 
the signal.  

•	 Flashing green: Port is input and receiving. The flashing frequency indicates the refresh rate of the 
signal. 

WATCHPAX 62 C     REAR VIEW
DATATON AB 220425-2202/BS

Frame Lock 
0 Out

Frame Lock 
1 Out

Frame Lock 
Sync Status LED

Stereo Phase 
Status LED

Frame Lock 
1 In

Frame Lock 
0 In

HouseSync  
Status LED

Check this info!

Rear panel, WATCHPAX 62
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CONNECT GPU SYNCHRONIZATION
There are two ways to connect GPU synchronization: 

•	 Sync generator into BNC connector.

•	 Cat 5 cable between the machines to synchronize. 

IMPORTANT: Do not connect a network cable between the Sync port on your WATCHPAX 62 and a 
network interface as this may cause permanent damage to the card inside. 

SDI SYNCHRONIZATION – MODEL C ONLY
The SDI outputs on your WATCHPAX 62 can be synchronized in three ways, or modes, as listed 
below:

MODE 1: INTERNAL SYNC
This is the default mode. Having this set will ensure synchronization between the different SDI output 
channels.

MODE 2: SDI SYNC CONNECTOR
This mode utilizes the dedicated synchronization connector of the SDI board and can be used with a 
bi- or tri-level synchronization signal. 
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•	 If the correct synchronization signal is received (a signal matching your display’s refresh rate), the 
streams will lock after a quick flash of the displays.  

•	 If an incorrect synchronization signal is received, the streams will still be output. However, an error 
message will be shown saying that no sync signal was found. 

•	 Successfully locking signals will not yield any message in WATCHOUT. 

•	 If synchronization signal is lost, a warning message will be shown in the production interface. 

•	 If synchronization is reconnected it might take up to 10 seconds for it to lock the streams again. 

•	 If WATCHOUT is set to use the SDI Sync Connector but no synchronization signal is present, the 
streams will not be output. 

MODE 3: SDI CONNECTOR
The standard SDI connectors can also be used as sync connectors. In order to synchronize your 
streams this way, the connector receiving the synchronization signal must be selected in the SDI 
settings of the WATCHOUT Display (WATCHPOINT) menu. 

•	 Capture source can also be used as a sync signal. 

•	 In case of incorrect synchronization signal or if no signal is present, the streams will be output but 
not in synchronization. 

•	 If a machine fails to lock to the synchronization signal all streams in the cluster must be restarted, 
even if, for example, two out of three devices successfully locked to the synchronization.
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5. EDID MANAGEMENT

Extended Display Identification Data (EDID) is a standardized data format for a display, such as a 
projector, screen or monitor, to describe its performance capability to a video source both for playout 
and capture purposes. The information exchanged in an EDID handshake includes the resolution, 
refresh rates and timings available in the display. 

EDID MANAGEMENT FOR PLAYOUT
This section is a walkthrough on how to manage EDID on a WATCHPAX 62 using NVIDIA’s control 
panel. The following functionality is provided: 

•	 Export EDID from a display to file. 

•	 Load EDID from file in order to emulate EDID on one or multiple outputs. This makes it possible to 
output a signal whether a display is connected or not. 

•	 Unload the emulated EDID in order to switch to the EDID of a connected display device. 

HINT: For fixed installations it’s recommended to emulate EDID for a more robust operation. This 
makes the WATCHPAX independent of the power state of the connected display device(s). 

ACCESS EDID MANAGEMENT SETTINGS 
To configure and setup EDID, access each media server locally. Do this either by a Remote Access 
(from the WATCHOUT production computer) or connect a USB keyboard/mouse and screen to your 
WATCHPAX 62. 

Connecting by Remote Access will automatically bring up the WATCHOUT Display window 
(WATCHPOINT). If you are using a local keyboard/mouse and screen, enter Ctrl-W to bring up this 
window. 

You’ll find more on this in the “Dataton WATCHOUT User’s Guide” in the section on “Display Devices” 
(Chapter 2:  Installation) and “Remote Access” (Chapter 4: Commands).

Follow this procedure to access EDID management settings: 

1.	In the menu select File >GPU Settings.  

Figure 1
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2.	Navigate to the Workstation >View System Topology (figure 2). 

3.	All outputs are listed within the A4000 section. Open the “Manage EDID” window by clicking the 
EDID link (figure 3). 

It’s possible to export EDID files to external USB devices or to store them locally on the W:\ drive. Files 
stored on the system (C:\) will disappear after a reboot.

EXPORT EDID 
To export EDID from a display, select an active display and press the Export button. 

Figure 2

Figure 3
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LOAD EDID
To emulate an EDID on selected display(s) from file (figure 4): 

1.	Select the “Load” tab. 

2.	Check the outputs to override. 

3.	Press the “Load EDID” button.

Figure 4

Figure 5
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UNLOAD EDID 
To remove the EDID emulation on selected displays (figure 6):

1.	Select the Unload tab. 

2.	Check the outputs to unload. 

3.	Press the Unload EDID button.

Figure 6

Figure 7
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EDID MANAGEMENT FOR HDMI CAPTURE
This section is a walkthrough on how to manage EDID on a WATCHPAX 62 using Deltacast’s control 
panel. The following functionality is provided: 

•	 Export EDID from a capture source to file. 

•	 Load EDID from file in order to emulate EDID on one or multiple capture inputs. This makes it possi-
ble to emulate a signal even if a capture source is not connected. 

•	 Unload the emulated EDID in order to switch to the EDID of the connected capture source. 

ACCESS CAPTURE SETTINGS 
Access each media server locally. Do this either by a Remote Access (from the WATCHOUT 
production computer) or connect a USB keyboard/mouse and screen to your WATCHPAX 62. 

Connecting by Remote Access will automatically bring up the WATCHOUT Display window 
(WATCHPOINT). If you are using a local keyboard/mouse and screen, enter Ctrl-W to bring up this 
window. 

You’ll find more on this in the “Dataton WATCHOUT User’s Guide” in the section on “Display Devices” 
(Chapter 2:  Installation) and “Remote Access” (Chapter 4: Commands).

Follow this procedure to access capture settings: 

1.	In the menu select File >Capture Settings.  

Figure 8
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2.	The Deltacast control software will start. Go to the IO control  (figure 9). 

Figure 9 a

Figure 9 b
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3.	Select the HDMI capture card. 

Note: Only WATCHPAX 62 model C has more than one capture card.

EXPORT EDID 
1. To export EDID from a capture source, first select Read EDID to read and save the current EDID from 
the capture source.

Figure 10

Figure 11
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2. Choose the location to save the EDID. You can export to an external USB device or store it on the 
W:\ drive. Note that a reset to factory settings will delete files on the W:\ drive.

Figure 12 a

Figure 12 b
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LOAD EDID
1. To load the EDID to the capture source, select Custom EDID.

2. Choose the EDID to load on your drive and select Open to load the file into the WATCHPAX 62  
capture card .

Figure 13

Figure 14
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UNLOAD EDID

IMPORTANT: It is not possible to restore the capture input EDID with a regular reset or even a factory 
reset of the WATCHPAX 62. The only way to reset the capture card input to the factory EDID is to load 
it from a file saved on the hard drive of the WATCHPAX 62.

1. Choose the EDID to load from the directory W:\EDID\capture.

	» If your capture card identifies itself as a “Delta_h4k elp 20” in the Board field (see Figure 10)
choose the file named “delta_h4k_edid.bin”

	» If your capture card identifies itself as a “Delta_h4k2 elp 20” in the Board field, choose the file 
named “delta_h4k2_edid.bin”

2. Select Open to load the file to the WATCHPAX 62 capture card.

Figure 15
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6. WATCHPAX 62 MODEL S

WATCHOUT VERSION 
Version 6.7.2 or higher.

DIMENSIONS
	 Width   	 448 mm  
	 Height     	    90 mm 
	 Depth	    	 335 mm 
	 Weight     8 300 g

SHIPPING DIMENSIONS 
WATCHPAX 62 is shipped in a sturdy, custom-design, corrugated cardboard box with handle.  
Dimensions as below:

	 Width   	 519 mm  
	 Height     	 180 mm 
	 Depth	    	 475 mm 
	 Weight     8 300 g + approximately 1 900 g (power cable, box and packaging)

FRONT VIEW

Power on/off.Perforated front.  
Keep clear for ventilation.

Handle. 
Use both handles when  
carrying. Never suspend 
unit from handles!

Handle.



WATCHPAX 62 MODEL S	 32

CONNECTOR DESCRIPTION

1 Kensington lock

2 Power inlet IEC 60320 C14 

3 USB 3.0 port 1, 2, 3. 4

4 RJ45 10GbE Ethernet 1

5 RJ45 10GbE Ethernet 2
Currently disabled; reserved for future use.

6 DisplayPort v1.4 - 4

7 DisplayPort v1.4 - 3

8 DisplayPort v1.4 - 2

9 DisplayPort v1.4 - 1

CONNECTORS
WATCHPAX 62 model S:

Keep clear for ventilation

1

9
1

8
1

7
1

6
1

5
1

4
1

3
1

2
1

1



WATCHPAX 62 MODEL A	 33

7. WATCHPAX 62 MODEL A

WATCHOUT VERSION 
Version 6.7.2 or higher.

DIMENSIONS
	 Width   	 448 mm  
	 Height     	    90 mm 
	 Depth	    	 335 mm 
	 Weight     8 300 g

SHIPPING DIMENSIONS 
WATCHPAX 62 is shipped in a sturdy, custom-design, corrugated cardboard box with handle.  
Dimensions as below:

	 Width   	 519 mm  
	 Height     	 180 mm 
	 Depth	    	 475 mm 
	 Weight     8 300 g + approximately 2.6 kg (cables, box and packaging)

FRONT VIEW

Power on/off.Perforated front.  
Keep clear for ventilation.

Handle. 
Use both handles when  
carrying. Never suspend 
unit from handles!

Handle.
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CONNECTOR DESCRIPTION

1 Kensington lock

2 Power inlet IEC 60320 C14 

3 USB 3.0 port 1, 2, 3, 4

4 RJ45 10GbE Ethernet - 1

5 RJ45 10GbE Ethernet - 2  
Currently disabled; reserved for future use.

6 DisplayPort v1.4 - 4

7 DisplayPort v1.4 - 3

8 DisplayPort v1.4 - 2

9 DisplayPort v1.4 - 1

10 Audio input/output. XLR by break-out 
cable, 2 outputs, 1 input

11 Capture card HDMI 1.4 - 2 (RX 0)

12 Capture card HDMI 1.4 - 1 (RX 1)

WATCHPAX 62 A     REAR VIEW
DATATON AB 220914-2109/BS

1

10
1

9
1

8
1

7
1

6
1

5
1

4
1

3
1

2
1

1

CONNECTORS
WATCHPAX 62 model A:

Keep clear for ventilation

1

11
1

12



WATCHPAX 62 MODEL B	 35

8. WATCHPAX 62 MODEL B

WATCHOUT VERSION 
Version 6.7.2 or higher.

DIMENSIONS
	 Width   	 448 mm  
	 Height     	    90 mm 
	 Depth	    	 335 mm 
	 Weight     8 600 g

SHIPPING DIMENSIONS 
WATCHPAX 62 is shipped in a sturdy, custom-design, corrugated cardboard box with handle.  
Dimensions as below:

	 Width   	 519 mm  
	 Height     	 180 mm 
	 Depth	    	 475 mm 
	 Weight     8 600 g + approximately 2.6 kg (cables, box and packaging)

FRONT VIEW

Power on/off.Perforated front.  
Keep clear for ventilation.

Handle. 
Use both handles when  
carrying. Never suspend 
unit from handles!

Handle.
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CONNECTORS
WATCHPAX 62 model B:

CONNECTOR DESCRIPTION

1 Kensington lock

2 Power inlet IEC 60320 C14 1

3 USB 3.0 port 1, 2, 3, 4

4 RJ45 10GbE Ethernet 1

5 RJ45 10GbE Ethernet 2 
Currently disabled; reserved for future use.

6 DisplayPort v1.4 - 4

7 DisplayPort v1.4 - 3

8 DisplayPort v1.4 - 2

9 DisplayPort v1.4 - 1

10 Audio input/output. XLR by break-out 
cable, 2 outputs, 1 input

11 Capture card HDMI 1.4 - 2 (RX 0)

12 Capture card HDMI 1.4 - 1 (RX 1)

13 Frame-lock connector 1
14 Frame-lock connector 2

15 Status LED 2

16 Status LED 1

17 External sync

WATCHPAX 62 B     REAR VIEW
DATATON AB 220914-2110/BS

1

11 12
1

10
1

9
1

8
1

7
1

6
1

5
1

4
1

2
1

1
1

3

1

14
1

13
1

15
1

16
1

17
Keep clear for ventilation
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9. WATCHPAX 62 MODEL C

WATCHOUT VERSION 
Version 6.7.2 or higher.

DIMENSIONS
	 Width   	 448 mm  
	 Height     	    90 mm 
	 Depth	    	 335 mm 
	 Weight     8 800 g

SHIPPING DIMENSIONS 
WATCHPAX 62 is shipped in a sturdy, custom-design, corrugated cardboard box with handle.  
Dimensions as below:

	 Width   	 519 mm  
	 Height     	 180 mm 
	 Depth	    	 475 mm 
	 Weight     8 800 g + approximately 2.6 kg (cables, box and packaging)

FRONT VIEW

Power on/off.Perforated front.  
Keep clear for ventilation.

Handle. 
Use both handles when  
carrying. Never suspend 
unit from handles!

Handle.
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WATCHPAX 62 C     REAR VIEW
DATATON AB 220425-2202/BS

Capture and playout HD-BNC.

3G SDI:  
Eight independent channels 
that can be used either as inputs  
or as outputs. 

12G SDI/6G SDI: 
Supported by two channels  
(connectors 1 and 5).

1

18

15

15

15

CONNECTORS
WATCHPAX 62 model C:

WATCHPAX 62 C     REAR VIEW
DATATON AB 220425-2202/BS

1
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1
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1
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1
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1
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1

4
1

2
1

1
1

3

1

14
1

13
1
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1

16
1

17
Keep clear for ventilation

1

18

CONNECTOR DESCRIPTION

1 Kensington lock

2 Power inlet IEC 60320 C14 1

3 USB 3.0 port 1, 2, 3, 4

4 RJ45 10GbE Ethernet 1

5 RJ45 10GbE Ethernet 2 
Currently disabled; reserved for future use.

6 DisplayPort v1.4 - 4

7 DisplayPort v1.4 - 3

8 DisplayPort v1.4 - 2

9 DisplayPort v1.4 - 1

10 Audio input/output. XLR by break-out 
cable, 2 outputs, 1 input

11 Capture card HDMI 2 - 2 (RX 0)

12 Capture card HDMI 2 - 1 (RX 1)

13 Frame-lock connector 1
14 Frame-lock connector 2

15 Status LED 2

16 Status LED 1

17 External sync

18 Capture and playout HD-BNC
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10. WARRANTY, CONFORMITY AND DISPOSAL

LIMITED WARRANTY
DATATON AB (”Dataton”) warrants this hardware product against defects in materials and workman-
ship for a period of seven hundred and thirty (730) days from the date of original retail purchase. 

If you discover a defect, Dataton will, at its option, repair, replace, or refund the purchase price of this 
product at no charge to you, provided you return it during the warranty period, transportation 
charges prepaid, to the authorized Dataton vendor from whom you purchased it, any other autho-
rized Dataton sales point in the country of the original retail purchase or to Dataton itself. More infor-
mation is available from Dataton AB, see address. 

When returning an item please attach your name, address, email address, a description of the prob-
lem and a copy of the bill of sale or packing list bearing the appropriate Dataton serial numbers 
(where applicable) as proof of the date of original retail purchase. You are also advised to first contact 
the vendor or Dataton. 

This warranty applies only to hardware products manufactured by or for Dataton AB and labeled with 
the Dataton logo. This warranty does not apply if the product has been damaged by accident, abuse, 
misuse or misapplication, nor if the product has been opened or modified without the written permis-
sion of Dataton, nor if any serial number has been removed or defaced.

All implied warranties, including implied warranties of merchantability and fitness for a particular pur-
pose, are limited in duration to seven hundred and thirty (730) days from the date of original retail pur-
chase of this product. The warranty and remedies set forth above are exclusive and in lieu of all others, 
oral, written, express or implied. 

No Dataton dealer, agent or employee is authorized to make any modification, extension or addition to 
this warranty.*

Dataton is not responsible for special, incidental or consequential damages resulting from any breach 
of warranty, or under any legal theory, including lost profits, downtime, goodwill, damage to or 
replacement of equipment and property, and any costs of recovering, reprogramming or reproducing 
any program or data stored in or used with Dataton products. 
*If extended warranty terms have been agreed with Dataton at purchase, proof shall be presented.

Dataton AB 
Teknikringen 22 
SE 583 30 LINKÖPING 
Sweden

Email: warranty@dataton.se
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FCC NOTICE
Model: WATCHPAX 62, product number 3368

This device complies with Title 47 Chapter 1, Part 15, Subpart B of the Federal Communication  
Commission rules. 

Operation is subject to the following two conditions: 

(1) This device may not cause harmful interference, and 

(2) this device must accept any interference received, including interference that may cause undesired 
operation. 

This equipment has been tested and found to comply with the limits for a Class A digital device, pursu-
ant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environment. This equipment 
generates, uses and can radiate radio frequency energy and, if not installed and used in accordance 
with the instruction manual, may cause harmful interference to radio communications. Operation of 
this equipment in a residential area is likely to cause harmful interference in which case the user will 
be required to correct the interference at his own expense.



WARRANTY, CONFORMITY AND DISPOSAL	 41

DECLARATION OF CONFORMITY
Model: WATCHPAX 
Model number: 3368
Description: Media server
Responsible manufacturer: Dataton AB
Address: Teknikringen 22, SE-583 30 Linköping, Sweden

Dataton AB hereby declares that the product listed above, to which this Declaration of Conformity 
relates, complies with the standards and regulations below:

	 FCC  
	 Regulations Title 47 Chapter 1, part 15, subpart B, Class A: 
	 §15.107: Conducted Emission, AC power line 
	 §15.109: Radiated Emission

	 CE  
	 EMC Directive 2014/30/EU 
	 Emission according to EN 55032:2015, class A, +A11:2020 
	 Electromagnetic compatibility of multimedia equipment

	 Emission according to EN 61000-3-2:2014 
	 Limits for harmonic current emissions (equipment input current ≤ 16 A per phase)

	 Emission according to EN 61000-3-3:2013 
	 Limitation of voltage changes, voltage fluctuations and flicker in public low-voltage  
	 supply systems

	 Immunity according to EN 55035:2017 
	 Edition 2 Immunity characteristics – Information technology equipment

	Low Voltage Directive 2014/35/EU 
	EN 62368-1:2014 
Audio/video, information and communication technology equipment - Part 1: Safety 
requirements

	RoHS 2011/65/EU 
	EN IEC 63000:2018 
Technical documentation for the assessment of electrical and electronic products with respect to 
the restriction of hazardous substances

	 WEEE  
	 Directive 2012/19/EU Waste from electrical and electronic equipment

Conformity testing has been done by a third-party testing body. 

Linköping, October 2022

Björn Sandlund 
Founder and owner

3368: WATCHPAX



WARRANTY, CONFORMITY AND DISPOSAL	 42

DISPOSAL
Only for European Union and EEA (Norway, Iceland and Liechtenstein)

This symbol indicates that this product is not to be disposed of with your household waste, according 
to the WEEE Directive (2012/19/EU), the Battery Directive (2006/66/EC) and/or national 
legislation implementing those Directives.

This product should be handed over to a designated collection point, e.g., on an authorized 
one-for-one basis when you buy a new similar product or to an authorized collection site for 

recycling waste electrical and electronic equipment (EEE) and batteries and accumulators. Improper 
handling of this type of waste could have a possible impact on the environment and human health due 
to potentially hazardous substances that are generally associated with EEE. Your cooperation in the 
correct disposal of this product will contribute to the effective usage of natural resources.

For more information about the recycling of this product, please contact your local city office, waste 
authority, approved scheme or your household waste disposal.
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11. SUPPORTED FORMATS

VIDEO CAPTURE FORMATS

HDMI INPUT (MODELS A, B, C)
The HDMI input can capture signals within the HDMI 1.4 bandwidth specification with a maximum 
rate of 297 Mpixels/s. The maximum capture resolution is 4096 × 2160p at 30 Hz. HDMI audio 
capture is not supported by WATCHOUT. 

SDI INPUT CAPTURE FORMATS (MODEL C)
WATCHOUT can capture both interlaced and progressive formats. SDI audio capture is not supported 
by WATCHOUT. 

The following SDI interfaces are supported (Model C): 

RESOLUTION FRAMES PER SECOND                                               SINGLE LINK
PAL – – – – – – 50 – –
NTSC – – – – – – – 59.94 –
720p 23.98 24 25 29.7 30 – 50 59.94 60
1080i – – – – – – 50 59.94 60
1080p 23.98 24 25 29.7 30 – 50 59.94 60
DCI 2K 23.98 24 25 29.7 30 48 50 59.94 60
2160i – – – – – – 50 59.94 60
2160p 23.98 24 25 29.7 30 – 50 59.94 60
DCI 4K 23.98 24 25 29.7 30 48 50 59.94 60

VIDEO INTERFACE SDI COMPLIANCE

SD-SDI SMPTE 259M

HD-SDI SMPTE 292M

3G-SDI Level A SMPTE 424M, SMPTE 425-1

3G-SDI Level B-DS SMPTE 424M, SMPTE 425-1

6G-SDI SMPTE 2081-10

12G-SDI SMPTE 2082-10
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VIDEO PLAYOUT FORMATS

SDI OUTPUT FORMATS (MODEL C)

NOTE: Quad-Link Quadrant mode divides a UHD image into four HD quadrants or a DCI 4K image 
into four DCI 2K Quadrants. This will create four independent HD-SDI or 3G-SDI Level A streams 
depending on framerate. 

The following SDI interfaces are supported: 

 

RESOLUTION FRAMES PER SECOND                                                  DUAL LINK
1080p – – – – – – 50 59.94 60
DCI 2K – – – – – 48 50 59.94 60
2160p 23.98 24 25 29.7 30 – – – –
DCI 4K 23.98 24 25 29.7 30 – – – –

RESOLUTION FRAMES PER SECOND                                               SINGLE LINK
720p 23.98 24 25 29.7 30 – 50 59.94 60
1080p 23.98 24 25 29.7 30 – 50 59.94 60
DCI 2K 23.98 24 25 29.7 30 48 50 59.94 60
2160p 23.98 24 25 29.7 30 – 50 59.94 60
DCI 4K 23.98 24 25 29.7 30 48 50 59.94 60

RESOLUTION FRAMES PER SECOND                            QUAD LINK INTERLEAVED

2160p – – – – – – 50 59.94 60
DCI 4K – – – – – 48 50 59.94 60

RESOLUTION FRAMES PER SECOND                              QUAD LINK QUADRANT
2160p 23.98 24 25 29.7 30 – 50 59.94 60
DCI 4K 23.98 24 25 29.7 30 48 50 59.94 60

VIDEO INTERFACE SDI COMPLIANCE

HD-SDI SMPTE 292M
Dual-Link HD-SDI SMPTE 372M
Quad-Link HD-SDI Quadrant SMPTE 292M
3G-SDI Level A SMPTE 424M, SMPTE 425-1
Dual-Link 3G-SDI SMPTE 425-3
Quad-Link 3G-SDI Interleaved SMPTE 425-5
Quad-Link 3G-SDI Quadrant SMPTE 424M
6G-SDI SMPTE 2081-10
12G-SDI SMPTE 2082-10
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TIMECODE INPUT FORMATS

ANALOG AUDIO OUTPUT FORMATS (A, B, C)
WATCHPAX 62 can output two channels of balanced analog audio through an DB-26 HD to XLR 
breakout cable.

The XLR connectors on the breakout cable are mapped in WATCHOUT according to the table below.

DIGITAL AUDIO OUTPUT FORMATS
WATCHPAX 62 can output multi-channel (7.1) LPCM audio embedded with DisplayPort and HDMI. 

BREAKOUT CABLE LABELS WATCHOUT
Left In Timecode input
Right In N/A, reserved for future use
Left Out Output Channel 1
Right Out Output Channel 2

ANALOG AUDIO OUPUT RATES
44.1 kHz
48 kHz
88.2 kHz
96 kHz

FORMAT TYPE

Film 24 fps
EBU 25 fps
SMPTE 29.97 DF
SMPTE 30 (“B&W”)
SMPTE 29.97 NDF

DIGITAL AUDIO OUPUT RATES
44.1 kHz
48 kHz
88.2 kHz
96 kHz
176.4 kHz
192 kHz
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DISPLAYPORT OUTPUT FORMATS
WATCHPAX 62 complies with DisplayPort version 1.4 and each connector can output a resolution up 
to 4096 × 2160 at 120 Hz or 5120 × 2880 at 60 Hz. 

ADAPTERS 
The DisplayPort 1.4 to HDMI 2.0 active adapters shipped with WATCHPAX 62 models A, B, C 
support resolutions up to 4096 × 2160 at 60 Hz. 

NOTE: If your device uses HDMI 2.1 or higher you will need different adapters.

NOTE: The usage of passive adapters is not recommended as it may result in a lower maximum 
resolution. 

NOTE: Adapters are not shipped with WATCHPAX 62 model S. 

HDCP 
High-bandwidth digital content protection (HDCP) is not supported by WATCHOUT. 

PLAYBACK FORMATS 

SUPPORTED PLAYBACK FORMATS 
MPEG-2/H.262
AVC/H.264 
HAP 
HAP Q
HAP Alpha
Prores 422 Proxy 
Prores 422 LT
Prores 422
Prores 422 HQ
TGA 
TGA  + Alpha
TIFF
TIFF + Alpha

HARDWARE ACCELERATED VIDEO FORMATS
WATCHPAX 62 supports GPU-accelerated video decoding. Hardware acceleration is enabled by 
default in WATCHOUT and this property can be changed by the user per media item. The codecs 
supported are listed below.  

CODEC MAX COLOR MAX RESOLUTION MAX LEVEL MAX PROFILE FORMAT
AVC/H.264 8-bit 4096 × 4096 5.2 High 4:2:0
MPEG-2/H.262 8-bit 4080 × 4080 n/a n/a 4:2:0
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